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INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH INTEL PRODUCTS.  NO LICENSE, EXPRESS OR IMPLIED, 
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A "Mission Critical Application" is any application in which failure of the Intel Product could result, directly or indirectly, in 
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PARTS. 

Intel may make changes to specifications and product descriptions at any time, without notice.  Designers must not rely on the 
absence or characteristics of any features or instructions marked "reserved" or "undefined".  Intel reserves these for future 
definition and shall have no responsibility whatsoever for conflicts or incompatibilities arising from future changes to them.  The 
information here is subject to change without notice.  Do not finalize a design with this information. 

The products described in this document may contain design defects or errors known as errata which may cause the product to 
deviate from published specifications.  Current characterized errata are available on request. 

Contact your local Intel sales office or your distributor to obtain the latest specifications and before placing your product order. 

Copies of documents which have an order number and are referenced in this document, or other Intel literature, may be obtained 
by calling 1-800-548-4725, or go to:  http://www.intel.com/design/literature.htm  

Intel Retail Client Manager, Intel RCM, and Intel AIM Suite are trademarks of Intel Corporation in the U.S. and/or other countries.  
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1 Introduction 
Intel® Retail Client Manager (Intel® RCM) is a comprehensive digital signage solution, 
scalable to handle the most demanding needs of customers deploying multiple digital 
signage campaigns to complex networks of displays around the globe.  But at its core, 
the idea of Intel RCM is simple: deliver an idea or message to a screen.  To introduce 
you to Intel RCM we will show you how to perform this most basic task – take a 
message in the form of a picture and make that seen on-screen. 

For this introduction we are going directly to the heart of the system, the campaign.  
In Intel RCM a “Campaign” is what we call a digital display presentation.  A campaign 
can be as simple as a single image to very complex, with combinations of rich media 
such as images, videos, RSS feeds, and more.  For our first example of a campaign, 
we will create a very simple campaign to demonstrate the basic structure of the Intel 
RCM tool.  Later on we will explore in depth how to set up all of the elements for a 
successful digital signage deployment. 

1.1 Simple Campaign 
1. In Campaign Manager, go to the Campaigns tab, right-click and select New 

Campaign.  Next, we need to name the campaign.  It is useful to name the 
campaign something that is reflective of the content.  We are going to name this 
campaign “Candy”. 

 
2. We will now add our media content, or What will be displayed.  Under the General 

Properties column, click What. 

Notice the Preview of the zone on the right.  This campaign will be full screen.  
Later we will explore multiple zones. 
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Next, we will add our image to the campaign. Campaigns can use images, video, 
Flash, and HTML5. Multiple items can be used in a single campaign.  Again, we will 
explore more complex campaigns later, as this campaign will consist of a single 
image file.  Media files can be managed on Intel RCM or brought in from a local 
drive.  We will add a jpeg file from the local drive. 

3. To add a file, click Add on the ribbon and then select “file”.  Select the desired 
image file from the local drive. 
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4. To schedule when the image will play, click When.  By default, the play time is for 

one week.  We will not change anything now, but we will discuss scheduling in 
detail later on. 

 
5. To select where our campaign will be displayed, click Where.  For now, select 

Channel 1.  We will explore channels for more choices later. 
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6. To publish the campaign, click Publish on the ribbon.  Be sure to click Yes or OK 

through the confirmation and saving changes messages.  In a few moments our 
simple campaign will be seen on the player display screen. 
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This is Intel RCM at the most basic level.  Of course, any real campaign you create will 
probably be more complex (and interesting) than our sample.  There is an unlimited 
opportunity to create campaigns with playlists, videos, RSS feeds, and multiple zone 
layouts with complex scheduling shown to channels of displays across multiple 
geographic regions.  But the key concepts that apply to all of that complexity is the 
What, When, and Where illustrated in our introductory campaign. 
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1.2 Creating Your First Campaign 
The purpose of this section is to provide an introduction to the foundation of the Intel 
RCM components to create a dynamic campaign.  We will cover Creating a Channel, 
Registering a Player, and Creating a Multi-Zone Campaign with varying media.  

Below is a graphical representation of the Intel RCM landscape.  It may be helpful to 
refer to this exhibit as a reference as you familiarize yourself with Intel RCM. 

 

Intel Cloud (License Server) 

 

This is the Intel hosted and managed server 
that manages licensing for Intel RCM.  There is 
nothing for you to configure. The cloud is shown 
here for illustrative purposes only. 

RCM Server The Intel RCM Server is where the content is 
stored and distributed to the Intel RCM Players.  
The server may be locally hosted or cloud-
based. 

Intel RCM Campaign Manager The Intel RCM Campaign Manager is the 
management tool for media, campaigns, 
channels, scheduling and player management.  
This is where you will spend the bulk of your 
time interacting with Intel RCM. 

Intel RCM Player This is the system that is connected to and 
controls the Display. 

Intel Cloud 
(License 
Server) 
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1.3 Creating a Channel 
The idea of a channel in Intel RCM is very similar to the idea of a channel when talking 
about broadcast television. Channel(s) act as tuning for one or more campaigns or 
other content entities such as commands and tickers (more on those later).  For Intel 
RCM, players are assigned or "tuned in" to a particular channel where campaigns 
scheduled to be played back. 

There are two general scopes when working in Intel RCM Campaign Manager - the 
Domain scope and Project scope. The Domain scope can be considered publicly 
viewable, but narrowly modifiable.  The Project scope is limited to a specific project.  
We are going to work within the Project scope, and will discuss Domain scopes at a 
later time. 
1. At the Project scope: Expand Project from the Project Explorer pane then select 

Channels.  To open a tab for a new channel, right-click in the Channels (Project) 
tab area and select New or select the Home horizontal navigation and then click 
Channel.  

2. In the New Channel tab, enter a name for the channel. The Unique ID cannot be 
changed and is used as a reference for the backend database (Intel RCM Server). 

  

 
3. [Optional] Enter a description for the New Channel and add any pertinent 

information in the Notes field.  
4. On the right side of the Campaign Manager application window, there is a 

Category Details frame.  Select and modify Categories to help distinguish this 
channel from others, which can be used for various filtering mechanisms. 

5. Save the changes and you are finished if you are creating a New Channel at the 
Project scope.  If you are creating a channel at the Domain scope, you will need to 
toggle which projects in the domain can use the channel then select Import after 
you have made your selections. 
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Channels: How Do They Work? 

Channels eliminate the mapping of campaigns to individual players by aggregating 
many players to a single channel. Campaigns can be played on one or more channels 
simultaneously. Strategically creating channels in a logical way (by geography, by 
location type, by time zone, or another way) makes it easy to manage where 
campaigns will be played.  

1.4 Registering a Player 
Players are the end point where campaigns will be displayed. They can be managed 
locally or through the Intel RCM Campaign Manager after they are registered.  
Hardware requirements of the player depend on the campaign displayed (for example, 
static images, 1080p video, interactivity, etc.).  Player Configuration is where we will 
establish these settings and other properties of the display such as the resolution, 
refresh rate, number of connected devices (monitors), etc. 
1. In Campaign Manager, expand the Channels from the Project Explorer pane. 
2. After a channel has been created, select Create Configuration File to create an 

XML file.  
3. Copy the file created in the previous step to the Player System.  
4. In Player Configuration, go to File -> Configure and open the XML file. 
5. Run Diagnostics to confirm configuration. 
6. The channel displayed on the player can now be configured from the Player 

Configuration or Campaign Manager. 

 

How Does It Work? 

The Intel RCM Player displays a campaign by opening a channel to the Intel RCM 
Server. The content is pushed from the Intel RCM Server to channels, which 
determine which campaigns will be shown on individual displays. Approved campaigns 
are published, are refreshed at preset intervals, and can be pulled from the Campaign 
Manager.  A player can also report metrics to the Intel RCM Server at set intervals. 

1.5 Creating a Campaign 
The campaign is the entity that will display media on players. A campaign can be 
created to include any number of zones and content from multiple rich sources 
including video, RSS tickers, web resources, audio, commands, and more.  
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1. In Campaign Manager, go to the Campaigns tab, right-click and select New 

Campaign, or select Campaign from the ribbon and then name your campaign. 

 
2. In the campaign General Properties, click What. Create zones for your campaign 

by clicking and dragging your zone box.  You can also adjust your zone by 
position, percentage of screen or pixels.  To create additional zones right-click in 
the Preview of current zones.   
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For this campaign, we will use three zones:  Zone 1 is our main window with a 
16:9 aspect ratio, 80% of full screen. We can adjust the size of the main zone by 
clicking on the Zone Properties button on the ribbon, and changing the Zone Width 
and Zone Height both to 80%. 

 

 
Zone 2 will be our sidebar zone.  You can either click Add Zone on the ribbon, or 
right-click in an empty area in the Preview and select Add Zone from the context 
menu.  Our sidebar zone is going to be 20% zone width and 80% zone height.  
Adjust the size as in you did with the Main Zone.  You can position your new zone 
from the Zone Properties to start the X position at 80% and the Y position at 0%.  
You can alternatively position your new zone by clicking and dragging Zone 2 in 
the Preview.  
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Finally, we will now add our third zone.  Instead of a standard media zone, we are 
going to select a ticker zone from the ribbon.  Again, we will adjust the zone 
properties to our custom layout – 100% width, 20% height.  X is positioned at 
0%, Y is positioned at 80%. 

 

 
3. Next we need to add content to each of our zones. We can add Files (images, 

videos, Flash, HTML5), Web Resources (Web pages directly loaded in real time of 
playback), Remote File Drop (placing files onto remote machine for later use) or 
Existing Playlists (playlists that have already been added and are managed by 
Intel RCM).  For this campaign, we are going to use image and video files from our 
local hard drive.  To add to the Primary Zone, click on the main zone in the 
preview.  Now click in the white space of the Zone Playlist.   
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You can add media through the “Add Media” button in the ribbon, or alternatively 
right-click on the Zone Playlist white space and select Add > Add Media from the 
context menu.  

 

 
4. Select your files and click Open. 
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The files are now listed in playback order.  You can use “Play Order” in the ribbon 
or drag and drop to change the order if desired.   

From the ribbon you can adjust the playlist from “Ordered” to “Random by 
Duration”, “Random Count Based” or “Ordered Count Based”.   We are going to 
leave the default setting for “Ordered”. 

Also from the ribbon, we can adjust playback time of each item, if desired.  Like 
before, we will leave the default values for our campaign. 

5. Next, click on Zone 2 to add content. We are going to add a single image, which 
has been created to match the dimensions of this zone.   
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  Intel® Retail Client Manager 
June 2013   Training Manual 
Document Number: 329194-001  19 

Because there is a single image in the playlist, the image will appear as a static 
image. 

Finally, we need to configure our Ticker Zone.  Note the content in the Zone 3 window 
is set to “Static Content ”.  Here you can change the static content for any message 
you like, which will scroll at the bottom of the display.  You can accomplish this by 
direct editing, or copying and pasting content directly to this area.  You can also use 
Internet RSS feeds to automatically populate this area.  Click on the Ticker Zone in 
the preview to select and click the Automatic Content tab on the Zone 3 window.  
By default, the automatic content is set to the RSS feed for the Intel Pressroom.  You 
can easily add and remove multiple RSS feeds by right-clicking on the RSS feed and 
selecting from the context menu. 

 
For this campaign, we are going to use the default Intel Pressroom RSS. 

Now that the content for all three zones has been configured, the What for this 
campaign has been configured. 

6. Select When from the campaign General Properties to set the Schedule for 
Campaign.  By default, the campaign is scheduled to play for one week from the 
time of creation.  Let’s extend this campaign out until the end of June.  On the 
Schedule tab, pull down the End Date to see the calendar.  Select June 30. 
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 Other options for scheduling are detailed later in the Advanced section. 

7. Select Where from the campaign General Properties to designate the channel 
where your campaign will display. 

8. Highlight Channel 1 and click > to move it from Available Channels to Selected 
Channels. 
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9. Under What, click the Campaign Tab, select Full Screen to preview your 
campaign to verify content is displaying correctly. 
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10. You are now ready to publish the campaign.  This will automatically save changes 

you have made; however, at any time you may save changes to your campaign 
without publishing to come back to it later.  

Note: If a user does not have permission to publish, an admin will first approve the 
campaign before syncing to the player (more on User Permissions in a later module). 

 

How Does It Work?  

Approved content is pushed out to the players associated with the targeted channel.   
After the players have downloaded the campaign and its meta data (the schedule, 
etc.) even if the link between the player and the CMS is broken the player will 
continue to display the content. The player can refresh content at preset times.  

Now that you have created and deployed a Multi-Zone Campaign, you should have a 
basic working understanding of how to navigate around Intel RCM and how it works.  
The next sections will discuss advanced features and concepts in detail.   
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2 Advanced Operations 

2.1 Schedules 
Schedule defines the period during which a campaign/ticker/command is expected to 
play. There are two types of schedules, a campaign/ticker/command schedule, which 
is simply the schedule attached to a campaign/ticker/command and a project-level or 
shared schedule (also known as public schedule). Public schedules can be shared 
among different campaigns, tickers and commands within the same project.  

2.1.1 Types of Schedules 

Whether it is a campaign/ticker/command schedule or a public schedule, all schedules 
are classified as basic and recurring. A basic schedule consists of a start date and time 
and a finish date and time. Such a schedule will render an associated 
campaign/ticker/command as being eligible for continuous play out within that period.  

A recurring schedule, on the other hand, is pattern based. This means it can allow a 
campaign to play on a certain time of the day (“dayparting”) or certain day of the 
week, etc. in a recurrent manner. The recurrent schedule can be further enhanced by 
introducing additional play blocks or alternatively excluding existing play blocks in an 
asymmetric manner.  

2.1.2 Basic Schedule 

To create a basic schedule, open any campaign/ticker/command and select Basic from 
the ribbon under the Schedule tab. You can set the start date/time and end date/time 
of the schedule. By default, a new campaign has a 7 day basic schedule period.  

If you want the schedule to run for a set number of hours, days etc., you need to set 
the Number and unit field as appropriate. 

 

 

 
Title  Description  Notes  

1  Starts  Set the start date and 
time for the schedule  Campaign will start at that time  
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2  Ends  Set the end date and time 
for the schedule  Campaign will end at that time  

3  Number  
Set the number of unit 
that the schedule should 
run for  

For example, set the number as 20 and unit as min. This 
means that the schedule will run for 20 min. The ends 
field will reflect the proper end date/time.  

4  Unit  
Set the unit as seconds, 
minutes, hour, day, week 
as appropriate  

For example, set the number as 2 and unit as hours. 
This means that the schedule will run for 2 hours. The 
ends field will reflect the proper end date/time.  

2.1.3 Recurrent Schedule 

To create a recurrent schedule, open any campaign/ticker/command and select 
Recurrent from the ribbon under Schedule tab. By default, a new campaign has a 7 
day recurrent schedule period. 

 

This opens up the Recurrent Schedule Editor. Set the appropriate start and end date, 
daily play patterns and Recurrence pattern, and click OK to save that recurrent 
schedule.  
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A more detailed description of the Recurrence Editor is explained below.  
 

Feature  Title  Description  Notes  

Schedule 
Range  Start  Set the start date for the 

schedule   

End after  
Select this radio button to set 
the number of times the 
Campaign is expected to run   

Occurrences 
Set the number of times the 
campaign/ticker/command is 
expected to run   

End by  Set the end date for the 
schedule  

System will automatically calculate the 
number of occurrences until the end 
date. If you select End after option and 
click OK, the End by date will reflect the 
appropriate end date, based on the 
number of occurrences.  

Daily Play Occurs once Select this to set an exact time 
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Feature  Title  Description  Notes  

Times  at  of the day when 
campaign/ticker/command 
runs  

Occurs 
every  

Select this to set a range and 
an interval at which 
campaign/ticker/command 
runs  

For example, if you select occurs every 1 
hour between 00:00:00 and 23:59:59 
then the campaign/ticker/command will 
run every hour within a 24 hour period 
each day  

Single loop  
Select this if you want the 
Campaign to play once every 
day when it runs  

Campaign will play once and then will 
play again the next day at the same 
daily play pattern time  

Looping for  
Select this if you want the 
campaign to play for an 
extended period every day  

The looping for period defines the period 
each day during which campaign is 
eligible to play. NOTE: this is not a 
continuous play, rather it ensures that 
instead of single play, campaign gets to 
play for an extended period.  

Recurrence 
Pattern  

Daily  

Every x days  

Select this to set a recurrence interval. 
For example, if you select every 2 days 
then campaign will run every alternate 
day until the end date. 

Every weekday  Select this to play campaign on 
weekdays only 

Weekly  

Occurs every x weeks on  

Select this to set a recurrence interval. 
For example, if you select every 2 weeks 
then campaign will run every alternate 
week until the end date.  

Different days checkboxes  Check the days of the week you want 
the campaign to play 

Monthly  

The x day of every x months  

For example, select First Monday of 
every 1 month to ensure that campaign 
plays first Monday of each month until 
the end date. Campaign will not play on 
any other day.  

Day x for every x month  

For example, select day 7 of every 1 
month to ensure that campaigns plays 
7th of each month until the end date. 
Campaign will not play on any other day.  

Yearly  Occurs every x year  For example, select occurs every 1 year 
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Feature  Title  Description  Notes  

to run the Campaign every year  

On the x day of x month  

For example, select first Tuesday of 
February to ensure that campaigns plays 
only first Tuesday of February each year. 
Campaign will not play on any other day.  

On the x month x day  

For example, select On February 7 to 
ensure that campaign plays on January 
7 of each year. Campaign will not play 
on any other day.  

Click OK in Recurrence Schedule Editor to save the schedule.  

Once set, the schedule calendar will show the proper schedule pattern in calendar 
view. Click Save from the ribbon to save the campaign/ticker/command.  

 

The above image shows a typical recurrent schedule calendar view. The recurrent 
schedule is set as: Start date is 25/6/2012, end date is 14/7/2012, occurs once at 
9:00:00, looping for 2 hours, with recurrence pattern as occurs every 1 week on 
Monday, Tuesday, Wednesday, Thursday, Friday. The schedule description at the 
bottom of the calendar view shows the exact number of occurrences for this recurrent 
schedule.  

2.1.4 Addition 

You can add additional play blocks outside the recurrent schedule pattern. To add 
additional play blocks, select any date in the calendar view and select Addition from 
the ribbon.  
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Enter a valid period in the Add Additional play UI. This additional play block must be 
non-overlapping with the recurrence pattern. Click OK to add the additional play.  

 

The calendar view will be updated with the additional play block. In the following 
image, on the 28th of June, the regular play period is from 9:00:00 to 11:00:00. In 
addition, the campaign will play from 12:00:00 to 13:00:00 as well. Campaign will not 
play between 11:00:00 to 12:00:00 as there is no playblock for that period on the 
28th. Note that additional block applies to that date only.  

 

 

2.1.5 Exclusion 

You can exclude certain period from regular recurrent pattern. To exclude a certain 
period, select any regular recurrent playblock in the calendar view and select 
Exclusion from the ribbon.  
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Enter a valid period within the regular playback that you want to exclude from the 
recurrence pattern. Click OK to add the exclusion range.  

  

The calendar view will be updated with the excluded play block. In the following 
image, on the 26th of June, the regular play period is from 9:00:00 to 11:00:00. If, 
for instance there is a live event that would be distracted by the campaign, we may 
want to exclude the campaign from playing between 10:00:00 to 10:30:00 (half an 
hour). The calendar view shows that the 9:00:00-11:00:00 regular play block has now 
been split into three blocks: 9:00:00 - 10:00:00 (valid), 10:00:00 - 10:30:00 
(excluded and shown as red block), 10:30:00 - 11:00:00 (valid). Campaign will 
therefore not play between 10:00:00 and 10:30:00 on the 26th of June. Note that this 
exclusion applies to only this date.  
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You can also exclude the entire regular play block from any day. To perform this, 
select the play block on any day, right-click to open the context menu and select 
Exclude this play span. This will exclude the entire play block and will be shown as a 
red block.  

2.1.6 Remove Addition/Exclusion 

To remove any addition or exclusion from the calendar view, select the appropriate 
play block and click Remove from the ribbon.  

To remove all additions or exclusions from the calendar view, click Remove All from 
the ribbon.  

2.1.7 Import/Export Schedule 

You can import a public schedule to a campaign/ticker/command. To import the 
schedule, open any new or existing campaign/ticker/command and select Import 
from the ribbon. This will open a schedule selection UI. Select the appropriate 
schedule and click OK. This adds the schedule to the campaign/ticker/command.  

Make some changes to the imported schedule inside the campaign/ticker/command. 
You can now export this edited schedule to a public schedule. To export the schedule, 
select Export from the ribbon. Enter a valid name for the schedule and click OK. This 
saves the edited schedule as a public schedule.  

For a detailed description of the importing/exporting of schedules, please refer to the 
technical help titled Importing/Exporting Schedules to a Campaign.  

2.2 Role and User Permission 
User level Permissions can be set by Domain Admin.  This can restrict access to 
projects, campaigns, content and publishing authority.  The concept is to have the 
ability to compartmentalize an organization's Domain so User Level Control can be set 
for different user’s activity. 

User permissions are established by Roles.  There are 5 roles automatically assignable 
with any campaign: Admin, Guest, MediaManager, PowerUser and User.  Within these 
users there are specific operational permissions that can be allowed or disallowed: 
Create, Read, Write, Delete, Publish, Approve, Import and Change Permission.  These 
Permissions will effect a user’s interaction with campaigns, campaign directories, 
schedules, tickers, commands, players, channels, and categories.  This allows 
delegation of appropriate power to staff while maintaining a secure operation.  
1. Creating A New User: In User View, click Insert on the ribbon under 

Administration tab, enter new user name and password (can also right-click in the 
User window) 

2. Modify Existing User: Double-click on a User.  We can Reset user’s password, 
name and email, as well as change user Roles. 

3. Cannot change Domain Admin username or roles, but can reset password.    
Domain Admin can also assign other users Domain Admin permissions. 
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How Does It Work?  

Based on the role permission, a user can have access to one or more projects.  The 
user will only have access to entities within that project, as defined by his roles.   

In addition, permissions can be granted on individual entities such as campaign, 
tickers, etc., as well as such entities as campaign zones.  This heightened level of 
security enables the system to offer enterprise level access to different entities.  All 
these permissions within a project are managed by the domain administrator.  

2.2.1 Users 

Each role has an association with one or multiple projects and consists of a set of 
permissions. When a role is assigned to a user, that user inherits all permissions for 
that role. By making changes to the role and saving those changes, it is possible to 
enforce those new changes to take effect immediately. When this happens, a logged in 
user is forced to log off. While permissions inherited from a role governs what a user 
can and cannot access, a user can also be assigned entity level permissions. Users 
must have appropriate permissions to make changes to users and roles as well as 
entity permissions.  

Select Users from Project Explorer under Domain tree view.  

  

This opens the all Users workspace. You can view current status of all users in this 
domain. You must have appropriate permissions to view this listview.  

 

 

  

The all users listview shows a number of information about the user: 

• Domain Admin – This shows whether the user is a domain admin. 

• IP address – This shows the IP address of the logged in user. 

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission1.png
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• Gateway IP –This shows the IP address of the gateway. For a private network 
hosting the CM service, IP and gateway IP are the same.  

• Status – This shows the status of the user (online or offline). 

• Last Login – This shows the date and time when the user last logged in to this 
domain. 

• Location – This shows the location of the Campaign Manager from where the user 
has logged in. 

• App Version – This shows the version and build number of the installed 
Campaign Manager 

• Last Edit – This shows when the user entity was last edited. Edit operation 
includes rename, password change, priority change and role change. 

• Last Editor – This shows which user last edited the user entity. 

• Created On - This shows when the user entity was created. 

2.2.2 Create User  

To create a user, select Insert User from Administration tab on the ribbon. This 
creates a new user workspace.  

 

 

Or, right-click inside all users listview workspace to open context menu and select 
New. This creates a new user workspace.  

 

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission3.png
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You can also create a new user workspace by pressing Ctrl+N. By default, the new 
user workspace is labeled as New User*. “*” denotes that the workspace is in edit 
mode.  

 

  

Enter a name, a valid password (must meet minimum requirements), a valid email 
address, and then select an appropriate priority from the Priority drop-down list.  

 

  
  

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission5.png
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Name  Enter a suitable name for the user  

Password  Enter a valid password. Password must meet the minimum requirements.  

Confirm 
password  Re-enter the password  

Email  Enter a valid email address  

Created  This shows when the user entity is created. This is read only.  

Modified  This shows when the user entity was modified. Created and Modified fields are the 
same when user is created for the first time.  

Priority  Select the priority assigned to a user. User will be able to modify the priority level 
of campaigns/tickers/commands which have the same or lower priority ranking.  

With the buttons provided, move appropriate roles from Available Roles listview to 
Selected Roles listview. You can assign multiple roles to the same user. When multiple 
roles having different permission templates and associated with the same project are 
assigned to the same user, then highest role prevails. Use the search control provided 
above each listview to return a filtered result, based on entity name.  

 

  

Now click Save from the ribbon to save the user. A yellow bar appears warning the 
user that synchronization needs to be initiated. This means that the newly created 
user exists only locally. Until synchronization happens and the service data gets 
updated, newly created user will not be able to login to the domain. Click Force 
Synchronization under the Home tab on the ribbon. The yellow bar will be removed 
after synchronization completes. You can now log into the domain with the new user 
credentials.  

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission7.png
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2.2.3  Edit User  

To edit any existing user, open the user workspace from all users listview. The 
following actions can be performed on the workspace:  

• Rename – change the name of the user 

• Email address – change the email address 

• Roles - Change the role assignment 

• Priority – Change the user priority 

• Password - To change the user password, click Reset password. This opens the 
Change Password dialog window. Enter a valid password and click OK. A message 
window appears informing user whether the password change was successful. 

 

  

Click Force Synchronization under the Home tab on the ribbon to sync the latest 
changes. Logged in user will be forced to log off to enforce these changes.  

Note: Only DomainAdmin or users with domainadmin privileges can change other user 
password. However users with domainadmin privileges cannot change DomainAdmin 
password.  

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission8.png
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2.2.4 Delete User  

To delete a user, select the user and press DEL from keyboard. Or, select the user 
and select Delete User from the Administration tab on the ribbon. You can also select 
the user, right-click to open the context menu and select Delete to delete the user.  

2.2.5 Set as DomainAdmin  

To assign domainadmin permissions to a user, select the user in all user listview. 
Right-click to open context menu and select Set As DomainAdmin. This assigns the 
user with domain admin privileges. When the user logs back in, user will have full 
access to the entire domain.  

User will now be able to make changes to all entities including all users, roles and 
roles permission. However this user will not be able to make any permission changes 
to the DomainAdmin since it is a system generated built-in user.  

Open the user that has been assigned domainadmin privileges. In the Roles page of 
the user workspace, the Selected Roles listview now includes a role called Domain 
Administrator.  

 

  

To remove domainadmin privileges from a user, select the user in all users listview, 
right-click to open the context menu and select Remove As DomainAdmin.  

2.2.6 Entity Level Permission for User  

User can be assigned specific permissions on specific entity. For example, even if a 
user has guest roles assigned (guest roles have read only permission for all entities), 
on a particular campaign the user can be assigned full permission. To assign such 
permission on a campaign, select the campaign and right-click and select Properties. 
This opens the Properties window, which lists the user and roles and their associated 
permissions on this entity. Click Change to add an existing user to the permission list.  

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission10.png
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Administration  
Check this if you want the user or role to have delegation authority. This means 
that a user who has Administration permission can assign full control to other 
users as well.  

Full control  Select this checkbox to check all checkboxes in the list. This includes: read, 
write, delete, publish, approve  

Read  

Check this to allow read permission on this Campaign. By default, all roles have 
read permission on Campaigns. Check Deny to deny read permission. If read 
permission is denied, user will not be able to see the Campaign in the all 
Campaigns listview.  

Write  Check this to be able to make changes to the Campaign. Check Deny to deny 
write permission.  

Delete  Check this to be able to delete the Campaign. Check Deny to deny delete 
permission.  

Publish  Check this to be able to publish the Campaign. Check Deny to deny publish 
permission.  

Approve  Check this to be able to approve the Campaign. Check Deny to deny approve 
permission.  

This opens the Select Users and Roles window. Move users from Available Users and 
Roles list to Selected Users and Roles list by using the buttons (>, », «, <). Click OK.  

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission11.png
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>  Use this button to move a single user or role from Available Users and Roles list to the 
Selected Users and Roles list  

»  Use this button to move all users and roles from Available Users and Roles list to the 
Selected Users and Roles list  

«  Use this button to remove all users and roles from Selected Users and Roles list to the 
Available Users and Roles list  

<  Use this button to remove a single user or role from Selected Users and Roles list to the 
Available Users and Roles list  

This opens the Properties window again. The list now includes the added user or role. 
Select the user or role and check all permissions that apply. Click OK. This saves the 
entity level permission for the user. For example, in the following image, user “collins” 
is given all permissions but denied Approve permission. This means that “collins” will 
be able to view the campaign, makes changes to it, delete the campaign as well as 
publish it. The only action “collins” is unable to perform is approve the Campaign.  

NOTE that “collins” is originally assigned guest role which allows read only permission 
on all entities. With the entity level permission, “collins” is now able to perform a 
number of actions on the selected campaign, as defined by his entity permissions. 
Similar permissions can be set on other entities, zones and ticker zones.  

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission12.png
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2.2.7 User Search  

To search users from all users listview, click inside the search control and enter the 
search text. Workspace will return a filtered result of users that have matching text 
string in the Name field. The string will be highlighted in yellow. Click “Click here” to 
cancel the filtering and return the full list of users.  

 

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission13.png
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2.2.8  User Status  

To view the online user status, select Users from Project Explorer under Domain 
treeview. This opens all Users listview. Users that are currently logged in to this 
domain will appear as online under the Status column. User icon will also denote the 
status of the user. The different user states that are supported by Campaign Manager 
include:  

• Online – This denotes user is currently logged in to this domain and active. This is 
denoted by a green overlay icon. 

 
• Offline – This denotes that user is not currently logged in to this domain or 

connection from user’s CampaignManager has dropped. This is denoted by a grey 
overlay icon. 

 
• Blocked – This denotes that user is currently blocked. Under blocked condition, 

user login will fail. To login successfully to the domain, user must be unblocked. 
This is denoted by a blocked overlay icon. 

 
• Inactive – This denotes that there are more users than the domain license 

permits. Users that are created last (Created On column has later date/time than 
others) will be marked as inactive. User login will fail until domain limit for users is 
increased. This is denoted by a red overlay icon. 

 
• When user limit is exceeded and user is in inactive state, a yellow bar is shown 

with a warning text that domain has exceeded the user limit. Open Configure 
Domain wizard in realm to update the domain limits. 

  

2.2.9 User Details View and Tasks  

To open user details view, select any existing user and press Ctrl+E. Or, select the 
user, right-click to open the context menu and select View Details. You can also 
open the Details View by selecting Details Window from View tab on the ribbon. The 
Details View panel for selected user is defined below.  

 

 

 

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission15.png
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1  Label and 
status  

This shows the name of the user and status. Status can be one of the four: 
online, offline, blocked and inactive. The user icon will also show an overlay for 
status: green for online, grey for offline, block for blocked and red for inactive.  

2  Status 
information  

This shows different information about the user i.e., IP address, gateway IP 
address, status, user’s Campaign Manager version, when the user last logged 
into the domain and user’s location.  

3  Tasks  This lists the most commonly used tasks for a user. Select the individual tasks 
to initiate it.  

4  Recent 
History  

This shows a certain number of history records (20) for the user in descending 
order of time.  

5  Refresh  Click this button to refresh the recent history  

6  More  Click this button to open a new history workspace labeled as History 
(username) which shows the entire history records for the user.  

A more detailed description of the individual tasks is given below: 

Manage 
permissions  

Select this to open the Roles page on user workspace. Assign appropriate roles 
to the user and save.  

Reset 
password  

Select this to open Change Password dialog window. Enter a new password and 
click OK. A message window confirms whether the password was successful.  

Block user  Select this to block the user. A message window confirms whether the user was 
successfully blocked.  

Delete user  
Select this to delete the user. A message window appears asking user to confirm 
the operation. Click Yes to confirm the delete operation. A message window 
appears confirming whether the delete was successful.  

2.2.10 Roles 

Role is an entity that defines the permissions levels for all other entities. A user is 
assigned with one or more roles. If multiple roles are assigned to the same user, then 
the highest role prevails. The association of role with one or more project defines 
whether the user is able to open that project.  
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2.2.10.1 Default Roles  

When a new project is created, five default roles are created and automatically 
associated with this project. The project name is used to label the roles who have pre-
defined permission levels. For example, if a new project called “Project1” is created 
then the five default roles created will be labeled as:  

• Project1_Admin 

• Project1_Guest 

• Project1_User 

• Project1_PowerUser 

• Project1_MediaManager 

2.2.10.2 Create Custom Role  

To create a new role, select Insert Role from Administration tab on the ribbon. You 
must have appropriate permission to create role.  

  

Or, you can select Roles from Project Explorer, right-click inside all roles listview and 
select New.  

 

You can also click inside all roles listview and press Ctrl+N to create a new role 
workspace. By default, the workspace is labeled  as New Role and opens on General 
Properties page. Enter a suitable name for the role. The Created on and Modified on 
fields represent when the role was created and last modified.  

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission21.png
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These read only fields initially have the same value when the role is created. Select 
Role Projects from the navigation panel.  

 

Associate the role with one or more projects by checking the project checkboxes. By 
default all project checkboxes are unchecked. Select a permission template from the 
drop-down list for each project. Select Permissions in navigation panel to view the 
permission levels.  

 

By default, the pre-defined permission levels are loaded when a permission template 
is selected. You can make changes to the permission page. To change the existing 
permissions, uncheck/check the different permissions as appropriate.  

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission23.png
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The different permissions for different entities are explained below. 

 

Campaign  

Create  Check this to allow user to create a new campaign in the associated 
project  

Read  Check this to allow user to view existing campaign in the associated 
project  

Write  Check this to allow user to edit existing campaigns in the associated 
project  

Delete  Check this to allow user to delete existing campaigns in the 
associated project  

Publish  Check this to allow user to publish a campaign in the associated 
project  

Approve  Check this to allow user to approve a campaign in the associated 
project  

Change 
Permission  

Check this to allow user to assign permissions to other users or 
roles. By default, DomainAdmin or users with domainadmin 
privileges have this permission.  

Campaign 
Directory  

Create  Check this to allow user to create a new directory in Project 
Explorer under campaign entity in project treeview.  

Read  Check this to allow user to view custom directory in Project Explorer 
under campaign entity in project treeview.  

Write  Check this to allow user to rename the campaign directory  

Delete  Check this to allow user to delete the campaign directory  

Schedule  Create  Check this to allow user to create a new public schedule in the 
associated project  
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Read  Check this to allow user to view existing public schedules in the 
associated project  

Write  Check this to allow user to edit existing public schedules in the 
associated project  

Delete  Check this to allow user to delete existing public schedule in the 
associated project  

Change 
Permission  

Check this to allow user to assign permissions to other users or 
roles. By default, DomainAdmin or users with domainadmin 
privileges have this permission.  

Ticker  

Create  Check this to allow user to create a new ticker in the associated 
project  

Read  Check this to allow user to view existing tickers in the associated 
project  

Write  Check this to allow user to edit existing tickers in the associated 
project  

Delete  Check this to allow user to delete existing tickers in the associated 
project  

Publish  Check this to allow user to publish a ticker in the associated project  

Approve  Check this to allow user to approve a ticker in the associated 
project  

Change 
Permission  

Check this to allow user to assign permissions to other users or 
roles. By default, DomainAdmin or users with domainadmin 
privileges have this permission.  

Command  

Create  Check this to allow user to create a new command in the associated 
project  

Read  Check this to allow user to view existing commands in the 
associated project  

Write  Check this to allow user to edit existing commands in the 
associated project  

Delete  Check this to allow user to delete existing commands in the 
associated project  

Publish  Check this to allow user to publish a command in the associated 
project  
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Approve  Check this to allow user to approve a command in the associated 
project  

Change 
Permission  

Check this to allow user to assign permissions to other users or 
roles. By default, DomainAdmin or users with domainadmin 
privileges have this permission.  

Player  

Read  Check this to allow user to view existing players in the associated 
project  

Write  Check this to allow user to edit existing player configurations in the 
associated project  

Delete  Check this to allow user to delete existing players in the associated 
project  

Channel  

Create  Check this to allow user to create a new channel in the associated 
project  

Read  Check this to allow user to view existing channels in the associated 
project  

Write  Check this to allow user to edit existing channels in the associated 
project  

Delete  Check this to allow user to delete existing channels in the 
associated project  

Import  Check this to allow user to import domain channels to project  

Change 
Permission  

Check this to allow user to assign permissions to other users or 
roles. By default, DomainAdmin or users with domainadmin 
privileges have this permission.  

Category  

Create  Check this to allow user to create new category  

Read  Check this to allow user to view category treeview in the associated 
project  

Write  Check this to allow user to edit category in the associated project  

Delete  Check this to allow user to delete category in the associated project  

Playlist  

Create  Check this to allow user to create a new playlist in the associated 
project  

Read  Check this to allow user to view existing playlists in the associated 
project  
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Write  Check this to allow user to edit existing playlists in the associated 
project  

Delete  Check this to allow user to delete existing playlists in the associated 
project  

Publish  Check this to allow user to publish playlist in the associated project  

Change 
Permission  

Check this to allow user to assign permissions to other users or 
roles. By default, DomainAdmin or users with domainadmin 
privileges have this permission.  

MediaLibrary  

Create  Check this to allow user to create a new media library in the 
associated project  

Read  Check this to allow user to view existing media libraries in the 
associated project  

Write  Check this to allow user to edit existing media libraries in the 
associated project  

Delete  Check this to allow user to delete existing media libraries in the 
associated project  

Import  Check this to allow user to import domain media library to project  

Change 
Permission  

Check this to allow user to assign permissions to other users or 
roles. By default, DomainAdmin or users with domainadmin 
privileges have this permission.  

User  

Create  Check this to allow user to create a new user  

Read  Check this to allow user to view existing users in the associated 
project  

Write  Check this to allow user to edit existing users in the associated 
project  

Delete  Check this to allow user to delete existing users in the associated 
project  

Role  

Create  Check this to allow user to create a new role  

Read  Check this to allow user to view existing roles in the associated 
project  

Write  Check this to allow user to edit existing roles in the associated 
project  
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Delete  Check this to allow user to delete existing roles in the associated 
project  

Report  Create  Check this to allow user to create reports  

History  Read  Check this to allow user to read project history  

Trigger  Write  

Check this to allow user to send trigger events to player. If this 
permission is unchecked, the trigger entity is removed from the 
Project Explorer. This is because with no write permission to send 
triggers, user has no reason to view the trigger workspace.  

If the role is associated with multiple projects, then all the projects appear under each 
entity in the Permission page. To view the projects and their related permissions for 
each entity, expand any entity in the permissions page.  

 

You can make independent permission changes to each project by 
checking/unchecking permission checkbox for each project. To view project related 
permissions only, select the desired project from the Project drop-down list.  
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2.2.10.3 Edit Role 

User must have appropriate permissions to make changes to roles. Editing an existing 
role includes the following operations: 

• Rename – Rename either from all roles listview by pressing F2 or open a role 
workspace and change the name. You can also select the role in all roles listview, 
right-click to open the context menu and select Rename. The role name will be in 
edit mode. 

• Change role projects – go to Projects in role workspace and check/uncheck all 
projects that apply as well as configure with appropriate permission templates 

• Role permission – go to Permissions in role workspace and check/uncheck all 
permissions that apply for each associated project 

• Click Save from the ribbon to save the changes.  

2.2.10.4 Delete Role  

To delete a role, select the role in all roles litsview and press DEL from keyboard. 
Alternatively, you can select the role and select Delete from Home tab on the ribbon. 
You can also select the role, right-click to open the context menu and select Delete. 
The role will be deleted from the domain. If a user is assigned with this role, then the 
role will be removed from the user workspace. A logged in user whose role has been 
deleted will be forced to log off. If the user tries to login again, his login will fail, 
unless he has other roles assigned to him.  

2.2.11 Entity-Specific Permission 

You can assign entity level permissions for users and roles on particular entities.  

2.2.11.1 Entity Properties 

To assign permission to an entity, select the entity and right-click to open the context 
menu. Select Properties. This opens the Properties window which lists the user and 
roles and their associated permissions on this entity. Click Change to add a user or 
role to the permission list and set appropriate permission for that user. Click OK to 
save the permission.  

Even if the user has a certain role that may or may not allow such operations for the 
generic entity, entity level permissions will enable the user to perform the actions on 
the specific entity (such as a particular campaign, a particular ticker, a particular 
command, a particular channel, a particular playlist, a particular media libraries and a 
particular schedule).  

2.2.11.2 Zone Permission 

You can assign zone permissions to a user. To assign permission to a particular 
campaign’s zone playlist, open the campaign and go to the What section. Right-click 
on any zone to open context menu and select Properties. This opens the Properties 
window. Add the appropriate user or role and configure the user or role with 
appropriate permissions (check all checkboxes that apply).  
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You can also assign permissions on ticker zone within a Campaign. To assign 
permission on ticker zone, right-click on ticker zone to open context menu and select 
Properties. This opens the Properties window. Add a user or role to the list and 
configure the user or role with appropriate permissions (check all checkboxes that 
apply).  

Note: Zone permissions enforce certain exceptions to the role permissions. These are 
explained below.  

 

User has role that 
denies read permission 

to all Campaigns  

If zone permission is provided on a Campaign for this user, then user 
automatically is assigned read permission on the Campaign. So user will 
see this Campaign in all Campaigns listview.  

User has no roles 
assigned  

If zone permission is provided on a Campaign for this user, then user 
automatically is assigned read permission on the Campaign. So when user 
logs in to the domain, he will be able to select the project in the Project 
selection UI. Normally, without any role, user will not be able to open any 
project.  

User has zone 
permission but then 

denied Campaign read 
permission  

The last permission applied prevails and user will not be able to view the 
Campaign.  

2.2.11.3 Administrative Permission  

In Properties window, check this checkbox to assign administration permission to user 
or role. A user assigned with this permission will be able to delegate full control to 
other users or roles. If a user or role is assigned administration permissions then that 
user can change its own restrictions on that entity.  

 

 

http://ryarc.net/CM6help/lib/exe/detail.php?id=tech:role_and_user_permission&media=role_and_user_permission28.png
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2.3 Playlists 
Playlist is a collection of media that can be added to a campaign.  

A playlist is always considered as public playlist, which means that it can be shared 
across different campaigns within the same project.  

Playlist can also contain another playlist as a media item.  

2.3.1 Create Playlist 

A playlist can be created either from context menu or from the ribbon.  

From context menu: To create playlist from the context menu, you need to:  
1. Click Playlist from Project Explorer. This opens all playlist listview workspace. 
2. Right-click on the workspace and select New from the context menu. This opens 

up a new playlist workspace. 
3. Add media to the playlist from context menu or ribbon 
4. Click Save from the ribbon. Enter a name for the playlist and click OK. 

From the ribbon, to create a playlist:  
1. Click Playlist from the Home tab on the ribbon under Insert Item ribbonBar. This 

opens a new playlist workspace. 
2. Add media to the playlist from context menu or ribbon. 
3. Click Save from the ribbon. Enter a name for the playlist and click OK. 

Note: You can add a playlist inside another playlist. However recursive playlist is not 
allowed.  

2.3.2 Types of Playlists 

Ordered - An ordered playlist plays all the media in exactly the same order as it is 
defined by the Order ID.  

Ordered playlist total duration is the sum of all the media duration and cannot be 
changed.  

For individual media, you can change duration, order, start and end date as well as 
volume and balance (only for media with audio) in the ribbon under playlist tab. 
However in ordered playlist you cannot change the play count.  

If individual media duration is changed, this will automatically reflect on the ordered 
playlist total duration.  
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Random by duration - A random by duration playlist plays all media but in random 
order. The total duration reflects the sum of all media duration.  

However this value can be edited. For individual media, you can change duration, 
count, start and end date as well as volume and balance (only for media with audio) in 
the ribbon under playlist tab. However in random by duration playlist, you cannot 
change the order of the individual media, as this is calculated by the application.  

If the total duration is less than the sum of all media in the playlist, then the number 
of media playing during that period is determined by the individual duration of each 
media. For example, a playlist has 3 images each with 7 sec duration and a total 
duration of 21 sec. If you change the total duration to 14 sec, then during the playlist 
play period, it can only play 2 images.  

If the play count is changed for individual media then that media will play that many 
times until the entire playlist count is exhausted.  

However the entire process will happen in a random order and no media will be play 
back-to-back.  

Randomly Count-based - A randomly count-based playlist plays only the number of 
media in random order, as defined by the play count, instead of total duration. For 
example, if the playlist count is 3 and there are 5 media in the playlist then in each 
play period, only 3 files get to play. For individual media, you can change duration, 
play count, start and end date as well as volume and balance (only for media with 
audio) in the ribbon under playlist tab.  
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If the play count is changed for individual media, then that media will play that many 
times until the entire playlist count is exhausted over multiple play periods. NOTE that 
in randomly count based playlist, no media will be play back-to-back.  

Ordered count-based - An ordered count-based playlist plays only the number of 
media (defined by the play count) in exactly the same order as the Order ID. For 
example, if the playlist count is 3 and there are 5 media in the playlist then in each 
play period, only 3 files get to play in the exact order. For individual media, you can 
change all the fields in the ribbon under playlist tab.  
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Note: If the play count is changed for individual media, then that media will play that many 
times until the entire playlist count is exhausted over multiple play periods.  

Import/export playlist - Playlist can be imported to an existing campaign from 
Helper window using drag & drop.  

Alternatively a customized zone playlist can be exported to a public playlist so that it 
can be shared across different campaigns within the same project.  

To import a playlist to a campaign: 
1. Open the campaign and switch to What section 
2. Right-click on zone playlist and select Add existing playlist. This opens the 

Helper window 
3. Select the playlist you want to import and drag & drop it to the zone playlist. You 

can either drag & drop it directly on the zone playlist or you can drag & drop it on 
the zone. 

4. Playlist is added as an item to zone playlist 

To export a zone playlist: 
1. Open the campaign and switch to What section 
2. Click Export on ribbon in Playlist tab 
3. Enter a name for the playlist and click OK 
4. Click Playlist on Project Explorer 
5. The recently exported playlist now appears in the all playlist list 

Update related Campaigns - Campaigns that are associated with a playlist can be 
updated automatically using this option, following editing of the playlist. To update the 
related Campaigns: 
1. Open a playlist and add a media to it 
2. Save the playlist 
3. Click Update related Campaigns from the ribbon in Playlist tab. This opens the 

Update Selected Campaigns UI.  
4. Select the campaigns you want to update and click Update Only. This will update 

the relevant campaigns. 
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If a Campaign is published then following Update playlist action, the campaign  will in 
edited mode.  

Note: The update playlist option updates the campaign s only locally. You need to republish 
the campaign  to have the changes reflected on the player.  

Update related Campaigns and Publish - Campaigns that are associated with a 
playlist can be republished automatically using this option, following editing of the 
playlist. To update and publish the related campaign s: 
1. Open a playlist and add a media to it 
2. Save the playlist 
3. Click Update related Campaigns and Publish from the ribbon in Playlist tab.  
4. If publish is successful, a task dialog will inform the user.  
5. Player will start playing the updated playlist upon syncing. 
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Note: The Update related Campaign and Publish option will publish all campaigns 
associated with that playlist. So care needs to be taken in using this option to prevent 
unintended changes from being published.  

Conditional play - Conditional play is defined as a set of conditions that define 
whether a media is likely to play on the CM Player.  

If conditions associated with a media are not met, then CM Player will not play that 
media on the screen.  

You can set conditional play either on a media within a playlist or a zone playlist or on 
a playlist itself within the zone.  

To set conditional play on a media or playlist: 
1. Open the playlist or zone playlist 
2. Select the media or the playlist, right-click and select Add Conditional Play from 

the context menu. You can also select Conditional Play from the ribbon. This 
opens the Helper window. 

3. Click Add Condition in the Helper window 
4. Assign the appropriate condition for the media or playlist item 
5. Click Save from the ribbon 

For more information on Conditional Play, see Campaign conditional play.  

2.3.3 Details View 

Select any playlist and press Ctrl+E or select View > Details View from the ribbon in 
View tab.  

This opens up the Details view panel.  
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What - You can preview media thumbnail of playlist items. Media specific information 
such as duration, size etc. are also displayed in this section.  

Tasks - Most commonly used functions associated with a playlist are listed in this 
section.  

Edit Playlist: This option allows you to open the playlist workspace.  

Show related Campaigns: This option allows you to view a filtered result of all 
campaigns that are associated with this playlist. The result includes active, published, 
expired and pulled campaigns. 

Manage permissions: This option allows you to assign users and roles to this playlist 
as well as configure their permission level. For example, if you want user “Joe” to be 
only able to read this playlist but not make any changes to it, then you need to,  
 
1. Click Manage Permissions on Tasks. This opens up the Properties UI. 
2. Click Change 
3. Select a user from Available Users and Roles list and move it to the Selected Users 

and Roles list 
4. Click OK 
5. Click on user “Joe” and in the bottom section select the appropriate permission. In 

this case, click the checkboxes for Read under Allow while select the remaining 
checkboxes under Deny. This will only allow Read permission for “Joe” for this 
playlist. 
 

 

Delete playlist: This option allows you to delete the playlist. A confirmation message 
appears. Click Yes to permanently delete the playlist.  
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Rename playlist: This option allows you to rename the playlist in the all playlist 
listview workspace.  

2.4 Commands 
Commands are actions we want to execute on the remote device.  

There are a number of predefined commands that we can execute but there are also 
ways to create our own custom commands.  

Example using Command Entity 

Like other Entities in Intel RCM, using the Command Entity is very similar to using the 
Campaign Entity.  You will use the same ideas of  What, When, and Where. Let’s walk 
through an example of restarting the Intel RCM Player. 
1. From the Commands Menu, select New Command from the ribbon (or right-click 

to get the context menu.)  We will name this command “Restart Player” 

 

 
2. Next, select What and scroll to select “Restart Intel® RCM Player/RCM Audio 

Player” 



 
 

   
  Intel® Retail Client Manager 
June 2013   Training Manual 
Document Number: 329194-001  59 

 

 

We can schedule this command to execute later, or by default the command will run 
immediately.  We will leave the default. 

 

 

3. Click to the Where tab to select the Channel to execute the command. Here we 
will move Channel one from Available Channels to Targeted Channels. 
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4. Now, click Publish to execute the command.  To view the results, click Execution 
Results. 

2.4.1 Create a Command 

Like every entity there are three ways to create commands.  

While in project view, we click on the command icon.  

One way is from the ribbon; we choose the command button under the Administration 
tab.  

 



 
 

   
  Intel® Retail Client Manager 
June 2013   Training Manual 
Document Number: 329194-001  61 

  

 

The second way is to righ-click and choose New from the context menu.  

  

The third way is with using the shortcut keys Ctrl+N.  

2.4.2 Add Command 

Adding an action to the campaign can be done in the What section of the command.  

There are 24 predefined actions that can be added and each action has description.  
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2.4.3 Add Schedule 

To edit the time we want the Command to be executed on the player we edit its 
schedule.  

The schedule is edited in the When section.  

 

When setting a schedule to a command there is an option for run immediately or at 
specific time under the Basic schedule.  
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There is also an option for inserting recurring schedule. 

2.4.4 Add Target Site 

To add a target site to a command we simply open the command, we go to the Where 
section and we choose the channels that we want the command to be executed to and 
we press on the ‘>’ button which puts the Available Channels to the Targeted 
Channels.  

 

 

2.4.5 Publish 

To publish a command we select the command and click Publish on the ribbon under 
the Home tab.  
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 We can also publish a command by right-clicking on the command and choosing 
Publish from the context menu.  

 

2.4.6 Approval 

To approve command for publishing we select the command and then click Approve 
on the ribbon under the Home tab.  
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Approval can also be made by right-clicking and selecting Approve from the context 
menu.  

 

 

2.4.7 Pulling 

If we want certain action to stop executing on the players we select the published 
command and click Pull on the ribbon under the Home tab.  
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We can also pull a command by right-clicking and selecting Pull from the context 
menu.  

 

2.4.8  Different Views 

There are three different views in Campaign Manager.  

• Small Icons 

• Large Icons 

• Details 
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We can change the view from the ribbon under the View tab and while in the 
command workspace with right mouse button click.  

 

2.4.9  Details View 

For each command there is a details view where we can observe several features.  

To toggle the Details view, select the ticker and with right mouse button we click on 
the Detail View.  
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Another way is by selecting the ticker and choosing Detail view from the ribbon under 
the view tab.  
1. What  - Under What section we can observe what action we want to perform with 

the command.  
2. When  - Under When section we can observe the schedule of the command.  
3. Where  - Under Where section we can observer the target sites (players) where 

the command has been published.  
4. Tasks  - Under Tasks section we can see if there are any tasks assigned to the 

specific command.  
5. Are We There Yet - Under Are We There Yet section we can observe what is the 

status of the command and if it has reached the players.  

Execution Results 

When a command is created and published we can see its execution results.  

The execution results can be found in the main features of the command. 

When we open the section we can see some information of the commands execution.  

• Occurred is for when the command occurred. 

• Machine gives us information on which machine this command occurred. 

• Channel gives us information about on which channel was the command executed. 

• Success gives us information if the command executed successfully. 

• Output gives us extra information about the command execution. For example if 
the command was Request Play Log than the result will be a link here which would 
take us to the execution results. 

Manage permission 

To manage command permissions, select a command and right-click and select 
properties.  

In properties we can manage which roles have which permissions over a command.  
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Command trigger 

Command trigger is a feature we use if we want to execute the command on the 
player immediately with triggering.  

To configure a trigger command we enter in the command and in general properties 
section we tick the option Use trigger.  
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After ticking this option a text box appears where we enter the code of the trigger.  

This code will be later used in order to initiate the trigger.  

After configuring the command for triggering we go in the trigger section in the 
projects view.  

 

When we want to trigger a command we choose the command, we then choose the 
players that we want this command to be played and we press on the button with the 
clapperboard.  
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History 

To see the history of the command we open the history section of the command and 
there we have almost all the actions that were done upon the selected command.  

 

For each action there is information about the Entity name, the entity type, Verb 
(Explaining what the action was), Description (Defining the action into more detail), 
User and IP address.  

Run executable command 

This command publishes an executable file such as an exe, bat or Windows PowerShell 
script and executes it to the remote player.  

This command is not dependent on the display and runs on the player’s pc software.  

In order to create command like this, we create new command and we select the Run 
executable command option in the What section.  
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We can see that there are two fields that require our input.  

The first one require to point to the executable exe, bar or PowerShell script file and 
the second one is to input the commands parameters.  

The command parameters are the parameters that can be used while executing this 
file in command line of windows.  

So for example if we upload batch script and input the command line parameters:  

/s/t:10 – this means that we want the file to execute in 10 seconds.  

/s – parameter for starting 

/t – parameter for setting the execution time 

Custom serial command 

There are LCD screens which can be connected to the machine with serial interface.  

These screens can receive commands through the serial interface for powering down, 
powering on without the need of our intermediate attention.  

In Intel RCM Campaign Manger we can create commands and save them so we can 
use them later.  

New command 

To create a custom serial command, in the What section select Custom serial 
command and there are option we need to input in order to define the command. 
Then we can save the command for later usage.  
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Command definition 

In the command definition we can set several options of the serial command.  
1. We can set the name of the command which we will alter save and reuse the 

command with the name. 
2. The Data filed explains the code for the serial command provided by the screen 

vendor 
3. Description is used to explain the data filed, so we can now what this code is used 

for 
4. Com Port we select the port that the screen is connected to the remote player. 
5. Parity we select the parity of the serial command that we are sending. 
6. There is also setting for the Baud rate, the stop bits and the Data bits. 

 

Note: We set this feature according to the instructions manual provided to us by the screen’s 
vendor.  

2.5 Conditional Play and Intel® Audience Impression 
Metrics Suite (Intel® AIM Suite) Integration 
Intel RCM comes with one of the peak features in digital signage called Conditional 
Play. The conditional play lets us organize our players by category and then play 
certain content from campaign to certain screens, without the need to create different 
campaigns.  

Apart from category based conditional play there is Intel AIM Suite based play. Intel® 
AIM Suite is a technology which with a help of a camera determines the number of 
users, their gender even their age. With the help of this technology we can make 
condition as which media will play on the screens based on its audience.  
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On the ribbon under the view tab we select the helper window button in order to see 
the options to set the conditional play.  

 

 

2.5.1 Category Based Play 

To set conditional play based on the category of the screen, in campaign under what 
section we select a media.  
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Below in the category match tab we select on which category of players we want the 
media to air.  

2.5.2 Intel AIM Suite Based Play  

Your Intel AIM Suite must be active prior to using this feature. For more information 
or to login to your account go to https://aimsuite.intel.com/. 

To link your Intel AIM Suite account to the network Check the box in either Player 
Configuration or Campaign Manager and confirm the Intel AIM Suite Network Address 
and Port Number. 

 

 

 

To condition a media to play with the help of Intel AIM Suite technology we select a 
media and we choose the Intel AIM AVA tab in the conditional play section.  
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• Gender Under the gender tab we can select for which gender this media is 

intended.  

• Audience Under the audience tab we can select the operator and for how many 
viewers we want to display the media.  

• History range Under the history range we can select for which age range is the 
media intended.  

2.5.3 Triggers 

In Intel RCM, a “Trigger” is a special campaign that runs only when an external 
resource sends a special trigger message to the player.  A trigger campaign can be 
setup as a trigger initially, or an existing campaign may be modified to be a trigger 
campaign.   Either way, the user will select the “Use Trigger” checkbox, and choose a 
Trigger Code.  The Trigger Code can be any unique alphanumeric text pattern.  The 
user also has the choice of selecting “Interrupt other campaigns immediately” which 
will start the trigger campaign as soon as the player receives the trigger code, 
otherwise the trigger campaign will begin as soon as the current campaign loop has 
completed. 
1. To configure a trigger campaign we enter in the campaign and in general 

properties section we select the option Use Trigger.  
2. After selecting this option a text box appears where we enter the code of the 

trigger.  

This code will be later used to initiate the trigger.  
3. There is also the option if we want the triggered campaign to interrupt the running 

campaign on the screen immediately.  
4. After configuring the campaign for triggering we go in the trigger section in the 

projects view.  
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5. When we want to trigger a campaign we choose the campaign, we then choose 
the Displays that we want this campaign to be played and we press on the button 
with the clapperboard.  

 

How Does It Work?  

Triggers operate as campaigns that are pushed out to individual Players like any other 
campaign.  Instead of being bound by a schedule, however, they are called upon when 
a triggering event occurs.  This can be any from any source that can initiate the Code 
to be sent to the player.  

Triggers can be highly customized and interact with a number of sources to create 
real-time interaction with the Display 

2.5.4 Domain and Project Level History 

History is a section in the Intel RCM Campaign Manager where we can inspect all the 
actions that took place over our entities and features in the campaign manager.  

In the domain level history, the history is recorded for all the entities of the domain:  

Users, Roles, Channels, Players, Media Libraries and Categories.  

For the project level history, the history is recorded for all the entities of the project:  

Campaigns, Commands, Tickers, Commands, Playlists and Schedules.  

For each entity, no matter if it is Domain or Project level we can see information 
about:  

• Entity Name: The name of the entity, for example the user name or the 
campaign name 

• Entity Type: Whether it’s a channel or user or campaign 

• Verb: What action took place, modifying, creating, deleting 

• Description: Gives some extra information about the user logged in and the 
domain 

• User: Tells which user performed this action 

• IP Address: The IP address of the machine we are performing this action 

• Gateway IP: The IP address of the gateway that the machine connects to the 
internet 

• Created On: The date and time of the action 
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2.5.5 History Search 

The history search is located at the top of the history window.  

The search is performed based on the entity name. Simply we start writing and the 
results are presented to us with auto-complete.  

 

2.5.6 History Settings 

To set the history settings to our preference we go to the domain level feature Control 
Panel and there we have the history settings.  
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There are two options we can set, the history to be cleared after certain time or after 
certain records.  

After setting the settings we save them by clicking Save.  

 

Under the history settings there is an option to clear the history.  

 

Note: Only domain admin users have access to the domain level history and the domain 
control panel and hence they are the only users who can manipulate with these 
settings.  

History filter 

While in history view we can filter our results by entities.  

To filter the history we select the search tab in the ribbon.  



 
 
 

Intel® Retail Client Manager 
Training Manual  June 2013 
80  Document Number: 329194-001   

While we are in domain history, we can filter our results by Channel, Player, Media 
Library, Category, User, Role, Project.  

 

 

While we are in project history we can filter our results by different entities, which are 
recorded actually in the project history.  

We can filter by Campaign, Ticker, Command, Channel, Player, MediaLibrary, Playlist, 
Schedule, Category and User.  
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We can retrieve the whole history from the popup that is appearing in the top.  
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3 Intel® RCM Sys Admin 
 

• Server setup; system connectivity of CM, CS, CMP; create realm and domains; 
Licensing setup 

• Ongoing diagnosis and management using AMT 
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4 Intel® RCM Business Admin 
  

• Manage user accounts including feature accessibility by roles (Media Maker Here): 
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Exhibit 1: Work Flow 

`The workflow below can be used as a Quick Start reference: 

 

  

Download/
Install CMS 
Manager & 

Player

Media: Content Library
Populate Content Library by 

uploading all media files, 
resources (RSS Feeds, web 

content, etc)

Create 
Campaign

Playlist
Predetermined 

playlist

Commands
Scripts embedded in 

campaigns. Useful tools 
like system updates, 
turnon/off, AMT, etc

Publish
Save the campaign created, will be prompted to 
Publish. Note if user does not have Publishing 

authority, an Admin will first Approve the 
campaign before synching to the player

When
Set Schedule for 

Campaign

Where
Select Channel & 

Player

What
Select Frames, 

add content (from 
Content Library or 
direct from source)

Connect to Server
Login to CMS with username/

password provided by 
DomainAdmin. Default Project is 

automatically created

Configure the CM Player
Create Channel, Select Create 

Configuration File to create XML File. Share 
this and open with the Remote Player 

Configuration to associate with a Channel . 
Run Diagnostics to confirm configuration.
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Exhibit 2: Network Topology 

 

 

  

 

 

 

 

 

 

 

 

 

Intel 
Cloud 

(License 
Server) 



 
 
 

Intel® Retail Client Manager 
Training Manual  June 2013 
86  Document Number: 329194-001   

Exhibit 3: Content Distribution Topology 

 

 

 

 

• Media is assigned to campaigns individually or through playlists. 

• Campaigns are distributed to one or several Channels. 

• Channels may display one or several campaigns simultaneously or by priority.   
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